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1 Legal Information

The information provided in this documentation contains general descriptions and/or technical
characteristics of the performance of the products contained herein. This documentation is not
intended as a substitute for and is not to be used for determining suitability or reliability of these
products for specific user applications. It is the duty of any such user or integrator to perform the
appropriate and complete risk analysis, evaluation and testing of the products with respect to the
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you
have any suggestions for improvements or amendments or have found errors in this publication,
please notify us.

No part of this document may be reproduced in any form or by any means, electronic or
mechanical, including photocopying, without express written permission of Schneider Electric.

All pertinent state, regional, and local safety regulations must be observed when installing and
using this product. For reasons of safety and to help ensure compliance with documented
system data, only the manufacturer should perform repairs to components.

Trademarks

Schneider Electric, ClearSCADA, EcoStruxure, Modbus, RemoteConnect, SCADAPack,
Telepace, and Trio are trademarks and the property of Schneider Electric SE, its subsidiaries
and affiliated companies. All other trademarks are the property of their respective owners.

Address

Schneider Electric

415 Legget Drive, Suite 101, Kanata, Ontario K2K 3R1 Canada
Direct Worldwide: +1 (613) 591-1943
Fax: +1 (613) 591-1022
Toll Free within North America: 1 (888) 267-2232
www.se.com

© 2020 - 2021 Schneider Electric Systems USA Inc.
All rights reserved.

http://www.se.com
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2 Technical Support

Questions and requests related to any part of this documentation can be directed to one of the
following support centers.

Technical support: Americas, Europe, Middle East, Asia

Available Monday to Friday 8:00 am – 6:30 pm Eastern Time

Check our
FAQs

Explore our extensive knowledge database and FAQ videos to
find answers quickly:

https://se.com/faq

Email us Save time by emailing us your inquiry and an expert will contact
you:

supportTRSS@se.com

Send us an email anytime.

Call us Need someone to provide some technical support?

· Toll free within North America: 1-888-226-6876

· Direct Worldwide: +1-613-591-1943

Technical support: Australia/New Zealand (Pacific)

Available Monday to Friday 8:00 am - 5:00 pm Australian Eastern Standard Time

Check our
FAQs

Explore our extensive knowledge database and FAQ videos to
find answers quickly:

https://se.com/faq   

Email us Save time by emailing us your inquiry and an expert will contact
you:

techsupport.pz@se.com

Send us an email anytime.

Call us Need someone to provide some technical support?

· Inside Australia: 13 73 28 (13 SEAU)

· Inside New Zealand: 0800 652 999

https://se.com/faq
mailto:supportTRSS@se.com
https://se.com/faq
mailto:techsupport.pz@se.com
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3 Safety Information

Important information

Read these instructions carefully, and look at the equipment to become familiar with
the device before trying to install, operate, or maintain it. The following special
messages may appear throughout this documentation or on the equipment to warn of
potential hazards or to call attention to information that clarifies or simplifies a
procedure.

The addition of this symbol to a Danger or Warning safety label indicates
that an electrical hazard exists, which will result in personal injury if the
instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

Please note

Electrical equipment should be installed, operated, serviced, and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out
of the use of this material.

A qualified person is one who has skills and knowledge related to the construction, installation,
and operation of electrical equipment and has received safety training to recognize and avoid the
hazards involved.
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Before you begin

Do not use this product on machinery lacking effective point-of-operation guarding. Lack of
effective point-of-operation guarding on a machine can result in serious injury to the operator of
that machine.

 WARNING

EQUIPMENT OPERATION HAZARD

· Verify that all installation and set up procedures have been completed.

· Before operational tests are performed, remove all blocks or other temporary holding means
used for shipment from all component devices.

· Remove tools, meters, and debris from equipment.

Failure to follow these instructions can result in death or serious injury.

Follow all start-up tests recommended in the equipment documentation. Store all equipment
documentation for future reference.

Test all software in both simulated and real environments.

Verify that the completed system is free from all short circuits and grounds, except those
grounds installed according to local regulations (according to the National Electrical Code in the
U.S.A, for instance). If high-potential voltage testing is necessary, follow recommendations in
equipment documentation to help prevent accidental equipment damage.

Operation and adjustments

The following precautions prevail:

· Regardless of the care exercised in the design and manufacture of equipment or in the
selection and ratings of components, there are hazards that can be encountered if such
equipment is improperly operated.

· It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or
unsafe operation. Always use the manufacturer’s instructions as a guide for functional
adjustments. Personnel who have access to these adjustments should be familiar with the
equipment manufacturer’s instructions and the machinery used with the electrical equipment.

· Only those operational adjustments actually required by the operator should be accessible to
the operator. Access to other controls should be restricted to prevent unauthorized changes in
operating characteristics.
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Acceptable use

 WARNING

UNACCEPTABLE USE

Do not use SCADAPacks or I/O modules as an integral part of a safety system. These
devices are not safety products.

Failure to follow these instructions can result in death or serious injury.

 CAUTION

EQUIPMENT OPERATION HAZARD

When devices are used for applications with technical safety requirements, the relevant
instructions must be followed. 

Use only Schneider Electric software or approved software with Schneider Electric hardware
products.

Failure to follow these instructions can result in minor or moderate injury.
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4 About the Book

Audience

 WARNING

UNINTENDED EQUIPMENT OPERATION

The application of this product requires expertise in the design and programming of control
systems. Only persons with such expertise are allowed to program, install, alter, and apply
this product.

Follow all local and national safety codes and standards.

Failure to follow these instructions can result in death or serious injury.

This manual is written for people who need to code custom C functions or function blocks for
SCADAPack x70 device logic using the EFB Toolkit. These individuals are typically: 

· Systems Engineers

Document scope

This manual assumes that:

· The SCADAPack RemoteConnect configuration software is installed and running.

· A new project has been created and SCADAPack RemoteConnect is communicating with the
SCADAPack x70 device, as described in the SCADAPack RemoteConnect Configuration
Software manual.

· EcoStruxure Control Expert version 14.0 or newer is installed. The latest Control Expert
software can be download from www.se.com.

This documentation describes using the Schneider Electric EFB Toolkit with SCADAPack x70
devices and SCADAPack RemoteConnect configuration software. It is intended a supplement to
the Help provided in the Unity EFB Toolkit, explaining the EFB Toolkit usage differences
between SCADAPack x70 devices and Modicon PAC devices.

Validity note

This document is valid for:

· SCADAPack x70 firmware version 9.5.1 and earlier

· SCADAPack RemoteConnect configuration software version 3.8.1 and earlier

http://www.se.com
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Product related information

Programming Language 'C'

The programming language 'C' is a powerful language that offers many features, such as
pointers.

But programming in 'C' naturally contains risks, for example:

· You can define a pointer and modify the address to which the pointer points freely in your
program.

· You can cast a pointer to any type you like, etc.

If you are programming function blocks in 'C', you have to be aware of outcomes from each of the
function blocks. A 'C' coded function block is a piece of code compiled from a standard 'C'
compiler used inside the SCADAPack logic environment. There are no security checks inside
SCADAPack x70 Logic Editor or inside the SCADAPack x70 device that check the function
block code for correct operation. If the code is not correct, the memory may be corrupted at any
location inside the SCADAPack x70 device. As a consequence, the SCADAPack x70 device
may crash or behave unexpectedly.

 WARNING

UNEXPECTED DEVICE BEHAVIOR

· Check the function block code to make sure that it is working correctly

· For the test and debugging phase, use the PLC Simulator in the SCADAPack x70 Logic
Editor instead of a real SCADAPack x70 device

Failure to follow these instructions can result in death or serious injury, or equipment
damage.

Schneider Electric does not take any warranty for 'C' coded function blocks written by users of
the EFB Toolkit. This is also valid for the consequences of damages or injuries caused by
incorrectly coded function blocks.

Working Manually on The Function Block Files

The files generated and managed by the EFB Toolkit are absolutely necessary to generate the
installable form of the family.

Any modification within this directory can lead to unexpected EFB Toolkit behavior or the
generation of wrong executable code and result in unexpected SCADAPack x70 device behavior.
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 WARNING

UNEXPECTED DEVICE BEHAVIOR

Do not modify or delete any file located in the family development directory (FFBDev) using
tools other than the EFB Toolkit.

Failure to follow these instructions can result in death or serious injury, or equipment
damage.

Moving / Deleting Files of Installable Form

These files are generated and managed by the EFB Toolkit and are necessary to install the
family into the SCADAPack x70 logic Libset.

Any modification within this directory can lead to unexpected EFB Toolkit behavior or the
generation of wrong executable code and result in unexpected SCADAPack x70 device behavior.

 WARNING

UNEXPECTED DEVICE BEHAVIOR

Do not move or delete any file located in the installable form directory (FFBInst).

Failure to follow these instructions can result in death or serious injury, or equipment
damage.

Related documents

Use this manual with the other manuals included in your SCADAPack x70 documentation set.
The table below describes the manuals available in the documentation set.

Folder Manual Content

Getting Started Getting Started · The SCADAPack x70 family of products
available in this release

· The basic steps to get your SCADAPack
x70 device operational

· Where to get more information about
configuring, monitoring and managing
your SCADAPack x70 device

SCADAPack
Software
Installation

SCADAPack Software
Installation

· Hardware and software requirements

· Installation procedures 

· Accessing help

· Troubleshooting guidance
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Hardware
Manuals

The hardware manual for
your SCADAPack x70
device

· Installation, wiring and addressing
information

· Diagnostics capabilities

· Maintenance recommendations

· Hardware specifications

Configuration
Manuals

SCADAPack
RemoteConnect
Configuration Software

· Setting up and managing projects for your
SCADAPack x70 device

PC Communication
Settings -SCADAPack
CommDTM

· Setting up communications between
SCADAPack RemoteConnect and your
SCADAPack x70 device

SCADAPack x70
Configuration

· Configuring SCADAPack x70 device
operation

Porting Guide for
SCADAPack E to
SCADAPack
RemoteConnect

· Moving from SCADAPack E to
SCADAPack RemoteConnect

· Locating SCADAPack E Configurator
features in SCADAPack RemoteConnect

· Locating SCADAPack Workbench
features in SCADAPack RemoteConnect

· Compatibility chart

Porting Guide for Telepace
to SCADAPack
RemoteConnect

· Moving from Telepace to SCADAPack
RemoteConnect

· Tutorial for creating a project

· Compatibility chart

Technical
Reference
Manuals

SCADAPack
Communication Interfaces
Technical Reference

· USB, serial and IP communications

· Mobile communications

· Dialup modem communications

SCADAPack Operations
Technical Reference

· The SCADAPack x70 device file system

· Command line operations

· Diagnostics operations

· Telnet server operations

· FTP server operations

SCADAPack SCADA
Protocols Technical
Reference

· DNP3 protocol support

· Modbus protocol support

· IEC 60870-5-104 protocol support
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Logic
Programming
Manuals

SCADAPack Logic
Programming Overview

· The differences between EcoStruxure
Control Expert (Unity Pro) and the
SCADAPack x70 Logic Editor
environment

· Key programming concepts

· Basic procedures needed to use the
SCADAPack x70 Logic Editor

SCADAPack Function
Blocks Technical
Reference

· The custom SCADAPack x70 function
blocks that are available for developing
IEC 61131-3 applications 

Using EFB Toolkit with
SCADAPack x70

· Using the Schneider Electric EFB Toolkit
with SCADAPack x70 devices and
SCADAPack RemoteConnect
configuration software

Security
Administrator
Manuals

SCADAPack Security
Administrator

· Configuring security on your SCADAPack
x70 device

SCADAPack Security
Technical Reference

· Security standards

· Security overview

· DNP3 Secure Authentication

· Diagnostics

· Attack vectors and requirements
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5 Cybersecurity

Cybersecurity is a branch of network administration that addresses attacks on or by computer
systems and through computer networks that can result in accidental or intentional disruptions.
The objective of cybersecurity is to help provide increased levels of protection for information and
physical assets from theft, corruption, misuse, or accidents while maintaining access for
intended users.

No single cybersecurity approach is adequate. Schneider Electric recommends a defense-in-
depth approach. This approach layers the network with security features, appliances, and
processes. The basic components of this approach are:

· Risk assessment: A systematic security analysis of the environment and related systems.

· A security plan built on the results of the risk assessment

· A multi-phase training campaign

· Network separation and segmentation: Physical separation of the control network from other
networks, and the division of the control network itself into segments and security zones.

· System Access Control: Controlling access to the system with firewalls, authentication,
authorization, and other software means, and traditional physical security measures such as
video surveillance, fences, locked doors and gates, and locked equipment cabinets.

· Device hardening: The process of configuring a device against communication-based threats.
Device hardening measures include disabling unused network ports, password management,
access control, and the disabling of all unnecessary protocols and services.

· Network monitoring and maintenance: An effective defense-in-depth campaign requires
continual monitoring and system maintenance to meet the challenge of new threats as they
develop.

· See Security Considerations in the Security Technical Reference manual

Contact us

For more information, refer to the Schneider Electric Cybersecurity Support Portal at
http://www.se.com/b2b/en/support/cybersecurity/overview.jsp.

Additional Resources

Industrial Control Systems Cyber Emergency Response Team (ICS-CERT)
https://ics-cert.us-cert.gov 

ICS-CERT Recommended Practices
https://ics-cert.us-cert.gov/Recommended-Practices

Center for Internet Security (CIS) Top 20 Critical Security Controls
https://www.cisecurity.org/cybersecurity-best-practices

FBI Cyber Crime
https://www.fbi.gov/investigate/cyber

http://www.se.com/b2b/en/support/cybersecurity/overview.jsp
https://ics-cert.us-cert.gov
https://ics-cert.us-cert.gov/Recommended-Practices
https://www.cisecurity.org/cybersecurity-best-practices
https://www.fbi.gov/investigate/cyber
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Guide to Industrial Control Systems (ICS) Security
https://www.nist.gov/publications/guide-industrial-control-systems-ics-security

WaterISAC Water Security Network
https://www.waterisac.org

https://www.nist.gov/publications/guide-industrial-control-systems-ics-security
https://www.waterisac.org
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6 Glossary of Terms

Term Meaning Description

Control
Expert

Software package Schneider Electric (EcoStruxure) software
package for configuring, programming and
managing Modicon PACs (formerly known as
Unity Pro with versions 13.1 and earlier).
SCADAPack x70 Logic Editor V14.0 and later is
based on components derived from EcoStruxure
Control Expert (Unity Pro) V14.0

EF Elementary Function In the context of this document, stateless
functions coded in C using the EFB Toolkit

EFB Elementary Function Blocks In the context of this document, instanced
function blocks that may have internal states,
coded in C using the EFB Toolkit.

ePAC Ethernet Programmable
Automation Controller

Refers to the Modicon M580 controller family

FFB Generalized reference to
functions and function blocks

In the context of this document, any EF and
EFB coded in C using the EFB Toolkit

PLC Programmable Logic
Controller

Industrial device for automating control of assets
and communicating with smart devices

RTU Remote Terminal Unit Generic industry term for the class of controller,
optimized for remote site installation, operations
and communication. SCADAPack products are
classified as RTU devices

SPx70 SCADAPack x70
(contraction)

Series of Schneider Electric RTU devices (e.g.
SCADAPack 57x family, SCADAPack 47x
family)

Unity Unity Pro and related
software environment

Previous name for Control Expert
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7 Introduction to the EFB Toolkit

The EFB Toolkit is tool independent from SCADAPack RemoteConnect that enables the user to
generate customized functions and function blocks, which can be used many times in different
applications. It provides a complete development environment for programming library content.
Elementary Functions (EFs) and Elementary Function Blocks (EFBs) are developed in C code
and are compiled for the target Schneider Electric device and simulator to natively execute in the
context of the device logic. 

Collectively, EFs and EFBs are known as FFBs.

The user-defined FFBs can be stored and managed in libraries in a manner similar to the way
standard functions and function blocks are delivered with SCADAPack x70 Logic. 

FFBs are developed with a reduced-functionality version of the ’C’ programming language. 

Refer to the help documentation in the EFB Toolkit V14.0 for general instructions. Where the
EFB Toolkit help documentation refers to Control Expert, in general the content applies to the
SCADAPack x70 Logic Editor expect where noted in this document.

Algorithmic FFBs that are developed in the EFB Toolkit operate in the same way as native
SCADAPack x70 logic FFBs.

FFBs developed using the toolkit are portable between, and can operate on:

· SCADAPack 470 family devices

· SCADAPack 570 family devices

· Modicon M580 ePAC devices

· PLC logic simulator running on a PC

See:

· Intent

· Version Limitations

· Getting the EFB Toolkit

· Installing the EFB Toolkit

· Licensing the EFB Toolkit

· Using the EFB Toolkit Documentation

· Family Structure

7.1 Intent

The EFB Toolkit is designed for creating simple, periodically executed custom code using the C
programming language. It is not intended to be programmed for complex tasks that call other
FFBs (EFs or EFBs), interact with the device operating system or with SCADAPack x70 device
peripheral hardware. It is intended to provide algorithmic extensions to the IEC 61131-3
programming languages.

18
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Custom FFBs that you create with the EFB Toolkit are installed in the logic Types Library Libset
along with the native SCADAPack x70 logic functions and function blocks. You can customize
where in the Types Library they appear.

7.2 Version Limitations

The following combination of product versions represent the minimum requirements for using the
EFB Toolkit with SCADAPack x70 devices:

· Unity EFB Toolkit V14.0

· EcoStruxure Control Expert V14.0 and later

· SCADAPack RemoteConnect R2.4.2 / 3.7.3 and later

· SCADAPack x70 Logic Editor versions 14.0 and later

· SCADAPack RemoteConnect projects:

o For SCADAPack 47x devices: applicable to all projects

o For SCADAPack 57x devices: applicable to projects using Libset V14.0 and later. For

projects using Libset V11.1, the project will need to have its Libset upgraded to V14.0 or
later. See the Upgrading the Logic Library topic in the SCADAPack x70 Configuration
manual.

7.3 Getting the EFB Toolkit

The EFB toolkit is available from the Schneider Electric website at:
https://www.se.com/ca/en/download/document/Unity_EFB_Toolkit_V14.0/ 

7.4 Installing the EFB Toolkit

Installing the EFB Toolkit V14.0 requires that EcoStruxure Control Expert V14.0 or later be
installed first.

When installing the EFB Toolkit for the first time, it provides a 21-day free trial.

If you have previously installed the Unity EFB Toolkit V8.0 for other Modicon products, the
license you have for that toolkit should continue to work with the EFB Toolkit V14.0 installation
for SCADAPack x70 and Modicon products.

If you are re-installing the EFB Toolkit software, the file ‘library.dsc’ located in the family
development directory may be overwritten with an empty, new file. This file contains the names
of the libraries and associated relationships. Backup the library.dsc file before re-installing.

7.5 Licensing the EFB Toolkit

1. Register the EFB toolkit using the following part number:

UNYSPUZFUCD80

2. If online registration is not possible, use the Schneider Electric customer support center
contact information indicated on the toolkit licensing dialogs (email or phone).

https://www.se.com/ca/en/download/document/Unity_EFB_Toolkit_V14.0/
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3. Add the part number provided and the registration codes shown to the registration dialog for
the software.

You will receive an authorization code.

4. Activate the software license by entering the registration information in the EFB Toolkit
dialog.

7.6 Using the EFB Toolkit Documentation

This EFB Toolkit documentation is a supplement to the EFB Toolkit built-in help. 

You can access the EFB Toolkit help in PDF format here: 

· C:\Program Files (x86)\Schneider Electric\Unity EFB Toolkit\Sdkc\Help

7.7 Family Structure

The elements in the user-defined FFBs and their associated content created in the EFB Toolkit
are arranged in a unit called a family. 

A family is installed in a named library within the SCADAPack x70 Logic Editor’s Libset. Each
EFB Toolkit project manages one family of FFBs.

A family may comprise: 

· Elementary Functions (EF) 

· Elementary Function Blocks (EFB) 

· Derived Data Types (DDT)

EFs are state-less functions where the output value or values are derived only from the
combination of the provided input values. When used in logic, the EF interface consists of inputs
and outputs. 

EFBs can use internal states of variables along with input values to derive their output values.
EFBs can preserve internal states through instance data, in the same way as native
SCADAPack x70 logic elementary function blocks. For creating EFBs, you can use public
variables, private variables and inputs/output variables in addition to the usual function block
input and output pins. See Using Parameters .22
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8 Coding for SCADAPack x70 EFs and EFBs

See: 

· How EFB Toolkit Manages Files

· Restricted Code

· Using Parameters

· Framework Code that Cannot be Edited

· Creating an Elementary Function (EF)

· Creating an Elementary Function Block (EFB)

· EN and ENO Parameters

· Managing STRING Types

· Managing ARRAY Types

· Managing DDT Structures

· Using a Table of Constant Strings

8.1 How EFB Toolkit Manages Files

The EFB Toolkit uses separate paths for the development (source code) folder and the
installation (output) folder. These paths can be configured in the EFB Toolkit using the File >
Settings dialog on the Directories tab. 

The development folder holds the source code files for the EFB Toolkit project. The installation
folder holds the compiled output content from the EFB Toolkit which is used for installation of the
EFs/EFBs/DDTs in to the SCADAPack x70 Libset using the Types Library Update tool.

The default paths for the development and installation folders are:

· C:\Users\<username>\Documents\Unity EFB Toolkit\FFBDev\

· C:\Users\<username>\Documents\Unity EFB Toolkit\FFBInstall\

The output includes a family.dsc file (the file used by the installation process), a library.dsc file,
folders containing code, optional help files and help resources such as images, and multi-
language comment and description files.

8.2 Restricted Code

Inside the C code called for an EFB or EF, only basic logic services and restricted C code
services are available. See EFB Toolkit Help: EFB Toolkit > System Services > Overview.

No other external calls are available.

The IDE for the EFB Toolkit permits compiling and linking a single module per EF and EFB. 

Where you have external code modules that you wish to include in EF or EFB code, and which
are external C or H files, use a #include directive to include the source in building the EFB C
code module. 
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External files need to use the restricted C code set as described in the EFB Toolkit > System
Services > Overview section.

External files included in EF or EFB code need to be installed in the development source folder.
For example:

· C:\Users\<username>\Documents\Unity EFB Toolkit\FFBDev\User_EFB\code\

8.3 Using Parameters

The configuration of the FFB parameters for EFB Toolkit generates content consistent with that
of other FFB types in the logic environment. The EFB Toolkit provides access for the following
parameter types:

· Inputs provide data to the function block logic that can be read

· Outputs provide data from the function block logic that are updated when logic code is
executed to write to them

· Inputs/outputs are bidirectional parameters where an attached external logic variable can
provide its present value to the EFB and be optionally updated by the EFB. This has the
advantage of not having to allocate separate variables and corresponding external logic
management. This type of parameter can also be useful for DDT structures where the internal
EFB logic can selectively update specific elements in a DDT without affecting other elements

· Private variables are retained in the function block instance data (part of the logic applications
data memory), but are only available for modification by the function block’s internal code

· Public variables are a way of providing additional information to the function block logic, or from
the function block logic, without exposing them on input or output pins. These are often used
for additional diagnostic information or accumulated data associated with operation of a
function block.

All of these parameters are included in the EFB instance data along with inputs, outputs and
inputs/outputs. These are preserved in the logic data across logic restart and power failure.

Programmed C code in an FFB may also use local variables that appear on the logic task stack.
Local C variables are temporary and are not part of the EFB instance data. The data on the
stack should be minimized to temporary working variables. Do not define large data structures,
such as arrays or other large data types, as local variables on the stack. Use PRIVATE data for
these so they can be reported and managed as part of the logic application memory space.
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Reference parameter types

The SCADAPack x70 library does not support installing a custom FFB whose parameters
include use of a reference parameter type. 

Type names prefixed by REF_ should not be selected as the data type for EF or EFB
parameters.

8.4 Framework Code that Cannot be Edited

When the EFB Toolkit automatically generates the EFB Header and EFB Source files framework
for an FFB, there are code sections that cannot be edited. Any changes made in those sections
will be overwritten. 

The affected sections commence with:

//{{ SDKC_HEADER_BEGIN  Do not edit. Any modification would be
lost

Or

//{{ SDKC_PROTOTYPE_BEGIN  Do not edit. Any modification would
be lost
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And end with:

//}} SDKC_HEADER_END

Or

//}} SDKC_PROTOTYPE_END

Do not modify and code or comments between these sections.

8.5 Creating an Elementary Function (EF)

Characteristics of EF functions and procedures: 

Method Description 

Function A function has 1 output value (return pin). 

Functions have only Inputs and Outputs

Procedure A procedure could have 1 to n output values (return pins) and 1 to m input
values. 

Procedures have only Inputs, Outputs and Input/outputs

After creating an EF, it cannot be renamed by the EFB Toolkit.

To create an EF

1. Launch EFB Toolkit.

2. Create a new family by clicking Family > New Family.

3. Provide a name for the family and the location of the family directory.

4. Create a new EF by selecting Create Family > Create EF/EFB.

5. Provide a name for the EF, select the EF radio button, and click OK.

6. In the EFB panel, select Function or Procedure from the Kind drop-down menu.

7. Provide inputs, outputs, or input/outputs, depending on the functionality.

8. Select Current Object > Analyse and Generate code.

9. Go to the EF Source and provide the C code logic in the EF fb_call_model typed

function.

10. Save and click Compile .

Compile analyses, compiles, and generates the actual family and makes the installable
form. 
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See: 

· EF Header Example

· EF Source Example

8.5.1 EF Header Example

The following program code shows the header frame which will be generated by the EFB Toolkit.

//{{ SDKC_HEADER_BEGIN  Do not edit. Any modification would be lost
// Filename : C_Pro_Add_Mul_Int.h
// PROCEDURE : C_Pro_Add_Mul_Int
// Version : 1.0
// Author : Auto generated EF/EFB

/*
This is the comment of the demonstration EF
This is the descriptive form of the demonstration EF
*/

#include "SystemLib.h"
#include "..\ddt.h"

// Additional header :
// None
//   +------------------------------+
//   |  C_Pro_Add_Mul_Int           |
//   +------------------------------+
//   |                              |
// --+- INP_1     ADD_OUTP         -+--
//   |                              |
// --+- INP_2     MUL_OUTP         -+--
//   |                              |
// --+- INP_3                       |
//   |                              |
//   +------------------------------+
//

IECBool fb_call_model C_Pro_Add_Mul_Int(
const IECInt INP_1,               // 
const IECInt INP_2,               // 
const IECInt INP_3,               // 
IEC_PARAM_RTE_OFFSET ADD_OUTP,    // This is the output pin1
IEC_PARAM_RTE_OFFSET MUL_OUTP     // This is the output pin2

) ;
//}} SDKC_HEADER_END

// TODO : Write here additional declarations.
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8.5.2 EF Source Example

The following program code shows the source frame which will be generated by the EFB Toolkit
as well as user C code logic in the function call of type: fb_call_model. This function is

called by the logic task to execute the EF code.

//{{ SDKC_HEADER_BEGIN  Do not edit. Any modification would be lost
// Filename : C_Pro_Add_Mul_Int.c
// PROCEDURE : C_Pro_Add_Mul_Int
// Version : 1.0
// Author : Auto generated EF/EFB

/*
This is the comment of the demonstration EF
This is the descriptive form of the demonstration EF
*/

#include "C_Pro_Add_Mul_Int.h"

//}} SDKC_HEADER_END

// TODO : Write here additionnal declarations.

//{{ SDKC_PROTOTYPE_BEGIN  Do not edit. Any modification would be lost
IECBool fb_call_model C_Pro_Add_Mul_Int(

const IECInt INP_1,               // 
const IECInt INP_2,               // 
const IECInt INP_3,               // 
IEC_PARAM_RTE_OFFSET ADD_OUTP,    // This is the output pin
IEC_PARAM_RTE_OFFSET MUL_OUTP     // 

)
//}} SDKC_PROTOTYPE_END
{

// TODO : Write here variables declarations.
IECInt *add_Out, *mul_Out;

add_Out = s_log_to_phy( ADD_OUTP );
mul_Out = s_log_to_phy( MUL_OUTP );

      *add_Out = INP_1 + INP_2 + INP_3;
      *mul_Out = INP_1 * INP_2 * INP_3;

      return TRUE ; // ENO value
}
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8.6 Creating an Elementary Function Block (EFB)

To create an EFB

1. Launch EFB Toolkit.

2. Create New Family by clicking Family > New Family.

3. Provide a name for the family and the location of the family directory.

4. Create a new EFB using INT data type by selecting Create Family > Create EF/EFB.

5. Provide a name for the EFB, select EFB radio button, and click OK.

6. In the EFB panel, provide inputs, outputs, or input/outputs, private, or public, depending on
the functionality.

7. Select Current Object > Analyse and Generate code.

8. Go to the EFB Source and provide the C code logic in the LanguageEntryPoint function

for the EFB.

9. Save and click Compile .

Compile analyses, compiles, and generates the actual family and makes the installable
form. 

After creating an EFB, it cannot be renamed by the EFB Toolkit.

See: 

· EFB Header Example

· EFB Source Example

8.6.1 EFB Header Example

The following program code shows the header frame which will be generated by the EFB Toolkit.

//{{ SDKC_HEADER_BEGIN  Do not edit. Any modification would be lost
// Filename : IntMulti1.h
// EFB : IntMulti1
// Version : 1.0
// Author : Auto generated EF/EFB

/*
This is the comment of the demonstration EFB
This is the descriptive form of the demonstration EFB
*/

#include "SystemLib.h"
#include "..\ddt.h"
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// Additional header :
// None

//   +-------------------------+
//   |      IntMulti1          |
//   +-------------------------+
//   |                         |
// --+- INP1             OUTP -+--
//   |                         |
// --+- INP2                   |
//   |                         |
//   +-------------------------+
//

#if defined(__arm__)
#pragma pack(4)

#else
#pragma pack(8)

#endif

typedef struct {
// Public variables...

// Internal variables...

// Function parameters...
IECInt INP1;                      // This is the input pin1
IECInt INP2;                      // This is the input pin2
IECInt OUTP;                      // This is the output pin

} IntMulti1_INSTANCE_T ;

#if defined(__arm__) && (__GNUC__==2)
#pragma pack(0)

#else
#pragma pack()

#endif

#if defined(EFFBDBG)
#undef LanguageEntryPoint
#undef SystemEntryPoint
#define LanguageEntryPoint LanguageEntryPoint_IntMulti1
#define SystemEntryPoint SystemEntryPoint_IntMulti1

#endif

IECBool fb_call_model LanguageEntryPoint(
PTR_LOG IntMulti1_instance  // Logical address of a IntMulti1_INSTANCE_T

) ;

IECByte fb_call_model SystemEntryPoint(
IECUInt type,
PTR_LOG IntMulti1_instance

) ;
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//}} SDKC_HEADER_END

// TODO : Write here additionnal declarations.

8.6.2 EFB Source Example

The following program code shows the source frame which will be generated by the EFB Toolkit
as well as user C code logic in the function call LanguageEntryPoint. This function is called

by the logic task to execute the EFB code.

//{{ SDKC_HEADER_BEGIN  Do not edit. Any modification would be lost
// Filename : IntMulti1.c
// EFB : IntMulti1
// Version : 1.0
// Author : Auto generated EF/EFB

/*
This is the comment of the demonstration EFB
This is the descriptive form of the demonstration EFB
*/

#include "IntMulti1.h"

//}} SDKC_HEADER_END

// TODO : Write here additionnal declarations.

//{{ SDKC_PROTOTYPE_BEGIN  Do not edit. Any modification would be lost
IECBool fb_call_model LanguageEntryPoint(

PTR_LOG IntMulti1_instance  // Logical address of a IntMulti1_INSTANCE_T
)
//}} SDKC_PROTOTYPE_END
{

// TODO : Write here variables declarations.
IntMulti1_INSTANCE_T *strInMulti1;

// TODO : Write here the code for your function block.
strInMulti1 = s_log_to_phy(IntMulti1_instance);
strInMulti1->OUTP = strInMulti1->INP1 * strInMulti1->INP2;

return TRUE ; // ENO value
}

//{{ SDKC_SYSTEM_BEGIN  Do not edit. Any modification would be lost
IECByte fb_call_model SystemEntryPoint(

IECUInt type,
PTR_LOG IntMulti1_instance

)
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//}} SDKC_SYSTEM_END
{

// TODO : Write here the code for the system call.
return 0 ;

}

The SystemEntryPoint function is called upon a system event such as a STOP to RUN
transition of the logic application. Usually, code does not need to be written for this function,
since code in the LanguageEntryPoint function can access system data bits or words to detect
applications starting or initializing.  See EFB Toolkit Help: EFB Toolkit > System Services >
Description > s_rd_sysbit, and, in the Logic Programming Overview manual, see System Status
Bits.

8.7 EN and ENO Parameters

As for other logic FFBs, those produced by the EFB Toolkit can optionally use the logic EN
(Enable input) and ENO (Enable Output) parameters.

These additional parameters can be used when the Show EN/ENO selection is enabled in the
FFB instance Properties dialog.

The EN (Enable input) parameter, when in the TRUE state enables execution of the FFB. When
in the FALSE state the FFB is not executed. No specific code is required in an EF or EFB to
use this functionality.

The ENO (Enable output) parameter is controlled by EF or EFB C code. By default, the last line
in the C source code is return TRUE; This sets the ENO output to a TRUE state. Where

desired, if the operation performed by an FFB produces invalid results, or for other user-defined
purposes, the ENO output can be returned as FALSE.
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The typical use case is for an ENO parameter from one FFB to be connected to EN parameters
on other FFBs so that consequential operations are not executed depending upon the result of
an earlier condition. 

8.8 Managing STRING Types

Note that SCADAPack x70 logic strings can support characters to the full length of the string
(i.e. without a NULL termination character), but you may see overflow errors if the string is used
with standard logic library functions. It is highly recommended that STRING variables in logic be
used in a way consistent with C programming (i.e. NULL terminate all strings).

It is recommended that EFB code handling strings and using string functions should force a
NULL terminator after the final character of the string variable. Remember to account for a NULL
character in the defined string length.

IMPLEMENTATION NOTE: Using an elementary STRING type configured on an OUT pin of an
EFB appears to have an incorrect type automatically defined by the EFB Toolkit. A suggested
workaround for this is to use an inputs/outputs type pin for STRING outputs or use a DDT string
array type. 

See:

· Example EFB Using STRING Parameters

8.8.1 Example EFB Using STRING Parameters

The intent of this EFB example is to demonstrate the use of STRING parameters on an EFB. 

This EFB (called myEFB_2) takes a string on the INP pin, removes the first 2 characters and
updates the output string (a string on the INOUT pin), providing a boolean status output (TRUE if
successful, FALSE if there are issues with the string lengths). The STRING variables may be
any length (e.g. a STRING type variable of 16 characters including NULL; a string[50] type of 50
characters including NULL). The EFB checks that the resultant string will fit in the output string,
enforcing NULL termination strings for both input and output strings. 

EFB template definition

In this example, the EFB Toolkit is configured with this EFB template definition.

31
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It is not strictly necessary for P_INSTR and P_OUTSTR to be defined as private elements for the
example code below. Doing so preserves their values in the EFB instance data since they are
included in the private data area. Alternatively, they could have been programmed using local C
variables (on the stack) as they are recalculated every EFB call. They are presented as private
data elements in this example to show the difference in C code treatment of local and instance
data.

Header file

The header file containing the instance data definition is automatically generated by the EFB
Toolkit and must not be edited. The important content for this example contains:

typedef struct {
// Public variables...
// Internal variables...
IECUDInt P_INSTR;            // Pointer to input string physical address
IECUDInt P_OUTSTR;           // Pointer to output string physical address
// Function parameters...
IEC_PARAM_RTE_OFFSET_LG INP;      // This is the input pin
IEC_PARAM_RTE_OFFSET_LG INOUTP;   // This is the input/output pin
IECBool OUTP;                     // This is the output pin

       } myEFB_2_INSTANCE_T ;

The IEC_PARAM_RTE_OFFSET_LG type is internal to the EFB Toolkit and is defined as:

typedef struct tagIEC_PARAM_RTE_OFFSET_LG
{
    IEC_RTE_OFFSET IECPtr_Log;
    unsigned short int Length;
} IEC_PARAM_RTE_OFFSET_LG;
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Where the IECPtr_Log field is the pointer to the string content logical management structure,
and the Length field defines variable string size.

.C source code file

The EFB source (.C code file) implementing this could be:

//{{ SDKC_PROTOTYPE_BEGIN  Do not edit. Any modification would be lost
IECBool fb_call_model LanguageEntryPoint(

PTR_LOG myEFB_2_instance // Logical address of a myEFB_2_INSTANCE_T
)
//}} SDKC_PROTOTYPE_END
{
  // This example EFB removes the first 2 characters of an input string 
  // and writes it back out to an output string
  // As the Toolkit appears to use the wrong type for STRING variables 
  // on an OUT pin, the implementation uses an INOUT pin for the result.

  // TODO : Write here variables declarations.
  myEFB_2_INSTANCE_T *inst;
  IECUInt InVarSize;
  IECUInt OutVarSize;
  IECUInt InStrLength;
  IECString InStr;
  IECString OutStr;
  IECBool Status;
      
  // TODO : Write here the code for your function block.
  inst = s_log_to_phy(myEFB_2_instance); // converts a logical to physical address
  Status = FALSE;

  if (inst)
    {
    // Convert the EFB input pin logical string struct to 
    // physical (char *) string
    inst->P_INSTR = (IECUDInt)s_log_to_phy(inst->INP.IECPtr_Log);
    inst->P_OUTSTR = (IECUDInt)s_log_to_phy(inst->INOUTP.IECPtr_Log);

    // Get the string variable sizes to avoid overflows
    InVarSize = inst->INP.Length;
    OutVarSize = inst->INOUTP.Length;

    InStr = (IECString)inst->P_INSTR;
    InStr[InVarSize-1] = 0; // force NULL terminator format on input string
    InStrLength = strlen(InStr);

    if (OutVarSize > InStrLength - 2)
      {
      OutStr = (IECString)inst->P_OUTSTR;
      strcpy(OutStr, InStr+2);  // Do the real work (copy from 3rd character)
      OutStr[OutVarSize-1] = 0; // force NULL terminator format on output string
      Status = TRUE;
      }
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    }    

    inst->OUTP = Status;
    return TRUE ; // ENO value
}

Example operation

8.9 Managing ARRAY Types

Like the mechanism for STRING types which use the IEC_PARAM_RTE_OFFSET_LG type

providing a logical pointer to the variable and its length, the same type is used for managing
ARRAY types.

In the case of arrays, the Length field indicates the number of elements in the array.

It is strongly recommended that ARRAY declarations for internal variables are made through
device instance data using FFB parameters (for example Private Data), and not by declaring
them as local C variables (on the stack). See Using Parameters .

See:

· Creating an Array Type

8.9.1 Creating an Array Type

To create a DDT of type array

1. Launch EFB Toolkit.

2. Create a new family by clicking Family > New Family.

3. Provide a name for the family and location of the family directory.

4. Create a new DDT by selecting Current Family > Create DDT.

5. Provide a name for the DDT and select the type of DDT as Array.

6. In the DDT Panel, fill in the details: variables, types and the comments.

7. Save and click Compile .

Compile analyses, compiles, and generates the actual family and makes the installable
form. 
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The new DDT is created and appears as one of the selectable data types while creating
EF/EFB parameters.

8.10 Managing DDT Structures

You can define arrays or data structures in the DDT section of the EFB Toolkit family
configuration. 

After creating a DDT, it cannot be renamed by the EFB Toolkit.

See:

· Creating a DDT Structure

8.10.1 Creating a DDT Structure

To create a DDT structure

1. Launch EFB Toolkit.

2. Create a new family by clicking Family > New Family.

3. Provide a name for the family and location of the family directory.

4. Create a new DDT by selecting Current Family > Create DDT.

5. Provide a name for the DDT and select the type of DDT as Structure.

6. In the DDT Panel, fill in the details: variables, types and the comments.

7. Save and click Compile .

Compile analyses, compiles, and generates the actual family and makes the installable
form. 

The new DDT is created and appears as one of the selectable data types while creating
EF/EFB parameters

8.11 Using a Table of Constant Strings

Declaring a table with constant strings in the following form is not supported, because of the
special runtime environment of an EF/EFB:

const char * cllbk_Tab[] = { "StringA", "StringB" };
s_Declare_Logical(cllbk_Tab);

In this case the strings will be stored somewhere in the DATA segment and pointers to the
strings will be stored in the array. The EFB Toolkit detects this issue during patching the
EF/EFB object file. A message will be displayed in the logging pane:

Symbol ‘_MYEF_Tab’ in file ‘MYEF_32.OBJ’ is in undefined code section.
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To help avoid this issue, a string table needs be declared in the following way:

typedef char STRING16[16];
const STRING16 cllbk_Tab[] = { "StringA", "StringB" };
s_Declare_Logical(cllbk_Tab);

In this case the strings will be stored directly in the array.
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9 System Services

See:

· Restrictions on Using EFB Toolkit System Services

· Using s_proc_type Service for SCADAPack x70

· Access to EBOOL Variables

9.1 Restrictions on Using EFB Toolkit System Services

The System Services and Common System for EF/EFBs in Control Expert are available for use
on the SCADAPack x70 device as described by the EFB Toolkit Help, with the exception of the
following services, which are restricted in SCADAPack x70 applications.

System Service Description Comment

s_obj_nbr Returns number of located objects DO NOT USE 

Not supported in SPx70

s_rd_internalwords Returns values of %MW words %MW words are not supported
in SPx70

s_wr_internalwords Writes values to %MW words %MW words are not supported
in SPx70

s_current_task Returns the value of the current logic
task

FAST = 3, MAST = 4, 

AUX0 = 5, AUX1 = 6

s_of_passw_check Checks password signature, HALTs
if incorrect

Not supported in SPx70

s_of_passw_test Tests password signature, returns
status

Not supported in SPx70

s_demask_it Enable interrupts after a critical
section

Not supported in SPx70

s_mask_it Disable interrupts for critical section
protection

Not supported in SPx70

s_proc_indic Indicator status Returns bAppliInit = 1, all other
bit fields not supported in
SPx70

s_proc_type Processor type See Using s_proc_type Service
for SCADAPack x70
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The use of the System Service functions s_event_func_xxx() in an EF/EFB, created by the EFB
Toolkit, implies that the EF/EFB instance cannot be online deleted.

9.2 Using s_proc_type Service for SCADAPack x70

The system service s_proc_type returns data pertaining to the platform type on which the logic
is running. The following data is provided for SCADAPack x70 types: 

DEVICEID structure element SCADAPack
47x value

SCADAPack 57x
value

PLC Simulator
value

typedef struct {

unsigned short
ProductRange;

0x3021 0x3021 0x0021

unsigned short
PlcIdentification;

0x0442 0x0242 0

unsigned short PlcModel; 0 0 0

unsigned short ReservedForFuture;0 0 0

unsigned short ComVersion;0x0100 0x0100 0x0013

unsigned short NumPatch; 0 0 0x0002

} DEVICEID

Determining the processor type may be useful in tailoring functionality for a specific device at
run-time, including the PLC simulator.

ComVersion is the commercial version number of the run-time logic engine.

NumPatch is the patch number where 0 = no patch, 1 = patch revision A, 2 = patch revision B,
etc.

9.3 Access to EBOOL Variables

SCADAPack x70 supports unlocated EBOOL variables.

When an EF or EFB interface contains a logical address of an EBOOL variable or an array of
EBOOL variables, do not convert this address to a physical pointer to access the variable.

The following EF/EFB code snippet is not supported:

typedef struct {
// Public variables...
// Internal variables...
// Function parameters...
IEC_PARAM_RTE_OFFSET_LG ST_00; // array of EBOOL variables
} ARRAYBITS_INSTANCE_T ;
...
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// Convert to physical pointers
ARRAYBITS = s_log_to_phy(ARRAYBITS_instance);
ST00 = s_log_to_phy(ARRAYBITS->ST_00.IECPtr_Log);
// Copy bits from the given array into local variables.
BIT0 = ST00[0];
...

A set of system services exists to access EBOOL variables. The usage of these system ser-
vices is mandatory when accessing EBOOL variables:

· s_rd_1bit() – gets the value of a single bit

· s_rd_16bits() – gets the values of 16 bits

· s_rd_Nbits() – gets the values of up to 32 bits

· s_rd_bit_attrib() – gets the value, history and force attribute of a single bit

· s_wr_1bit() – sets the value of a single bit

· s_wr_16bits() – sets the values of 16 bits

· s_wr_Nbits() – sets the values of up to 32 bits

· s_wr_bits_attrib() – sets the value, history and force attribute of up to 32 bits

These System Services internally manage access to EBOOL variables according to the given
logical address.
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10 Preparing Content for SCADAPack x70 Logic

See:

· Customizing Where in the Types Library Hierarchy that the New FFBs Will Appear

· Help on Type

· Building the EFB Library

10.1 Customizing Where in the Types Library Hierarchy that the New FFBs Will
Appear

You can select where in the Types Library hierarchy that the new function block(s) appear.

1. In the navigator tree, click Family. 

2. In the main window section, enter the Family Definition Name and Version.

3. Use the Target Library in Control Expert settings (also applies to SCADAPack x70 Logic)

4. Click Library Management to create library names and comments. 

5. Select the Library Name.

If the Target Library setting is not configured, the library content appears in the Libset hierarchy
as Unknown Library.

Example EFB Toolkit settings:

This results in the following content when installed in the Libset (as shown by the Types Library
Manager and Types Library Browser):

Library and family content can be later removed from the Libset if desired, using the Types
Library Manager.

40
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10.2 Help on Type

Help content can be provided for FFBs you create with the EFB Toolkit. Help is activated by the
SCADAPack x70 Logic Editor by clicking F1 when the FFB is selected, or by right-clicking on
the EF or EFB reference and selecting Help on Type.

1. Start by creating an HTML file for each EF and EFB. 

Create this using an external tool, with the filename exactly matching the EFB name and
extension .htm. 

2. Add the HTML content files to each of the language folders.

These can be a copy of the same file, or independent files for each language, but need to be
present in each of the language folders: CHI, ENG, FRE, GER, ITA, SPA. 

3. Create a HELP folder under the installation’s family folder as described in the EFB Toolkit
Help: EFB Toolkit Services and User Functions > Help on Type. 

4. Place any images or other resource files associated with the HTML files in the HELP folder
(not in the language folder along with the .htm file). 

5. When developing the HTML help content, references in the .htm file for each image or other
resource in the HELP folder need to be prefixed with a relative path to the HELP folder. For
example:

<p class="p_BodyText"><img width="123" height="90" 
style="margin:0;width:123px;height:90px;border:none" 
src="..\HELP\com_open.png"/></p>

The Types Library Update tool installs the .htm help files from the language folders and the
resources (such as images) from the HELP folder. The installation adds only the .htm files for
the EFB or EF name, and the content of the HELP folder to the target library. No content outside
of the HELP folder will be installed. 

10.3 Building the EFB Library

Version Numbers

For each EF or EFB whose content is modified, make sure you increment the EFB Version, in
the top-right of the EFB panel tab prior to building the final content for release. Doing this eases
the updating of projects using the EFs or EFBs.

It is recommended that for each new released build of the family content you also increase the
family Version, in the top-right of the Family panel tab. Doing this makes it clearer that the
correct content is being updated into the logic Libset.

Language Settings

The build steps that generate the installation files may produce warnings associated with
language files. The following settings are recommended if multi-language comment files are not
being used. 
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See File > Settings > Language tab.

Generating Installation Files

Use the EFB Toolkit Analyses, generates, compiles button  to generate the library content,
ready for installation.

Where the output pane indicates error or warning conditions, address each issue. More detailed
information on warning conditions can be found in the EFB log tab for affected EFs or EFBs.

To avoid a common warning on function block parameters, make sure you enter comment text
for each EF and EFB definition as well as for each parameter in the EFB Panel.

Additional compiler and linker messages may be of assistance where warning messages are not
clear. See File > Settings > Build Options tab and choose a lower Warning Level Analysis
selection or uncheck compiler or linker Suppress messages options.

You will see the following message when all the EFs and EFBs in the EFB Project Toolkit are
successfully built and are ready to install:



3.9.1

Using EFB Toolkit with SCADAPack x70 Preparing Content for SCADAPack x70 Logic

43



3.9.1

Using EFB Toolkit with SCADAPack x70 Installing the New EFB Library in the SCADAPack x70 Libset

44

11 Installing the New EFB Library in the SCADAPack x70 Libset

In the same way that user defined DFBs are installed in a Libset, FFBs produced by the EFB
Toolkit needs to be installed in SCADAPack x70 Logic Editor’s Libset to make them available for
user logic applications.

1. Make sure that SCADAPack RemoteConnect, the SCADAPack x70 Logic Editor
(UnitySoControl.exe), and Control Expert (Unity Pro) are not running.

2. If you need to install the family content in the Control Expert (Unity Pro) Libset for Modicon
PACs, use only the EFB Toolkit’s File > Install family in Libset mechanism. If you do not
want the family content installed for Modicon PACs, skip this step.

3. To install the family content in the SCADAPack x70 logic Libset, use the SCADAPack x70
Logic Types Library Update tool instead:

a. Select the path to the folder containing the EFB Toolkit installation output (family.dsc file).

b. Select Libset V14.0 or later. 

See Version Limitations .

c. Click Install Family.

For more information, see Installing a Family in the Logic Programming Overview manual.

4. Restart SCADAPack RemoteConnect, create or open a project, and open the SCADAPack
x70 Logic Editor.

5. If this is the first time this family content is being used in the project, skip to step 15.

6. Open the SCADAPack x70 Logic Editor’s Tools > Types Library Manager.

7. Right-click on <Application>.

8. Select Compare Project with Library. 

The EFB or EF version number differences are displayed.

9. If there are differences, select Update All.

10. Confirm OK that a Rebuild All is required. 

11. Click OK in the dialog showing the list of EFBs that will be updated.

12. Confirm the modification.

13. Click OK.

14. Close the Types Library Manager.

15. Modify the application as required, including using new or modified FFB content.

16. Use the Type Library Browser or FFB Input Assistant to add the new FFB content.

17. Build the logic project

18. Use SCADAPack RemoteConnect’s Write to Device function.

19
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19. Test the application.

It is recommended that the PLC Simulator be used to test the operation of developed EFs
and EFBs prior to using them on a SCADAPack x70 device. See the safety warning in
Programming Language 'C' . 11
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12 Embedded and Simulator Target Code

EFs and EFBs can execute code in target SCADAPack x70 devices and in the PLC Simulator. 

· SCADAPack x70 execution uses ARM object code

· Modicon M580 ePAC uses ARM5 object code

· The PLC simulator uses x86 object code

The EFB Toolkit compiles and links for each of these environments when building the family
content. 
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